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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Discovery and Dependency Mapping 
Inventory 

Release Notes 
Software version: 7.61 / January 2010 

This document provides an overview of the changes made to Discovery and Dependency Mapping Inventory 
(DDM Inventory) for version 7.61. It contains important information not included in the manuals or in the 
online help. 

Conventions Used in this Document  

In This Version

Major Enhancements

Compatibility Notes

Agent and Scanner Support Information

Obsolete Features

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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Conventions Used in this Document  
By default, when you install the DDM Inventory server software, all the components will be in one of the 
locations specified in the following table. The placeholders are used to represent the DDM Inventory 
program and data folders referenced in this document: 

Folder Placeholder Platform Default Location 

Windows  
Server 2008 
x64 

C:\Program Files (x86)\Hewlett-
Packard\DDMI\7.61

Program 
Files 

<InstallDir> 

All others C:\Program Files\Hewlett-Packard\DDMI\7.61

Windows  
Server 2008 

C:\ProgramData\Hewlett-Packard\DDMIData Files <DataDir> 

Windows 
Server 2003 

C:\Documents and Settings\All Users\ 
Application Data\Hewlett-Packard\DDMI

You can customize both of these locations when you install the DDM Inventory server. 
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In This Version 

Introduction 

These release notes are for DDM Inventory 7.61. This new version of the product is the upgrade path for 
users of DDM Inventory 7.5x, 7.60, and Enterprise Discovery 2.5x.  

If you want to see what features have been introduced in previous versions of DDM Inventory (formerly 
called Enterprise Discovery), you can read the Release Notes for those versions available on your installation 
CD under bin\documentation.  

License Schema 

Each DDM Inventory server can collect data from a maximum of 50,000 inventoried devices and 60,000 
discovered devices in total. The port limit is 150,000 ports (whichever comes first). A DDM Inventory 
Aggregator can support 50 servers and up to 500,000 devices. 

Updated Third-Party Components 

• MySQL 5.0.87  

• Java Runtime Environment (JRE) 1.6.0_17  

• OpenSSL 0.9.8l  
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Major Enhancements 

New Rule Tabs in the SAI Editor 

From version 7.60, DDM Inventory supported rule-based application teaching. It enables you to add two 
types of application rules, the File Version Data rule and the Installed Package rule, to the applications. In 
this version, the SAI Editor offers two new tabs, the Package Rules tab and the Version Data Rules tab, to 
show all the rules that you create. When you click a rule in one of these tabs, the status bar shows the total 
number of the corresponding rules found in the current SAI. The Go to Application option from the right-
click menu navigates to the application (which the current rule belongs to) in the All Contents tab.  

To view the details of the rules for an SAI, or edit the properties of the rules for the User SAIs, perform the 
following steps: 

1 Right-click the desired rule. 

2 Select the Properties option from the right-click menu. 

3 In the Application Rule Wizard, you can view or edit the properties of the rule. 

Alternatively, you can also access the Application Rule Wizard by double-clicking the rule. 

Automount (AutoFS) Drives 

In this release the DDM Inventory provides the new Automount (AutoFS) Drives option (on the Software 
Details> Drives tab of the Scanner Generator) to disable scanning of auto-mounted drives. This is beneficial 
as many auto-mounted drives mount NFS shares, which are usually big and take a long time to scan.  

When the option is unchecked (the default setting), the scanner will not scan auto-mounted drives. The 
scanner will not attempt to mount any indirect automount drives. It may mount a direct automount drive if 
it comes across its mount point during the software scanning process, but the direct automount drive itself 
will not be scanned if its real drive type is excluded from scanning. 

When checked, the automount drives are scanned only if all of the following conditions are met: 

• The directory where the drive’s mount point is located is itself getting scanned. For example, it is located 
on a drive for which the corresponding drive-type checkbox is checked. 

• The drive-type checkbox for the real drive type of the automount drive is also checked. For example, an 
auto-mounted NFS drive will only be scanned when the Network Drives checkbox is also checked. 

• The drive is a direct automount drive or if the drive is an indirect automount drive, it has to be either 
already mounted or during the scanning process the scanner has to encounter a symbolic link pointing to a 
location within the indirect automount drive’s directory structure. 

The following example shows how these three conditions are met: 

A direct automount DVD drive mounted under /usr/local/cd (where /usr/local is located on a local 
hard drive) is scanned only when both Local Drives and CD and DVD Drives checkboxes are checked. 

Primary IP Address Identification 

In this release the DDM Inventory introduces a new hwNICIPAddressFlags field as part of the scanner’s 
hardware data. It indicates whether the IP address is primary or not. The DDM Inventory server takes this 
new field into consideration when deciding which IP address should be used as the Primary IP address of the 
device. 
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Scanner Enhancements 

• The CPU detection logic has been updated and can handle new CPUs. 

• The scanner has been enhanced to support the latest version of SMBIOS (2.6.1). 
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Compatibility Notes  

Reports Database Changes 

Additions 

• The hwsmbiosOnboardDevicesExtendedInformation table has been added. 

• The hwNICIPAddressFlags column has been added to the hwNICIPAddresses table. 

• The hwsmbiosSystemBIOSRelease and hwsmbiosEmbeddedControllerFirmwareRelease columns 
have been added to the hwsmbiosBIOSInformation table. 

• The hwsmbiosSystemSKUNumber and hwsmbiosSystemFamily columns have been added to the 
hwsmbiosSystemInformation table. 

• The hwsmbiosProcessorCoreCount, hwsmbiosProcessorCoreEnabled, 
hwsmbiosProcessorThreadCount, and hwsmbiosProcessorCharacteristics columns have been 
added to the hwsmbiosProcessorInformation table. 

• The hwsmbiosSlotSegmentGroupNumber, hwsmbiosSlotBusNumber, hwsmbiosSlotDeviceNumber, 
and hwsmbiosSlotFunctionNumber columns have been added to the hwsmbiosSystemSlots table. 

• The hwsmbiosMemoryArrayRank column has been added to the hwsmbiosMemoryDevice table. 
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Agent and Scanner Support Information  
With the release 7.61, the Scanners and Agents support the following operating systems: 

• Windows 7 

• Windows 2008 R2 

• Mac OS X 10.6 

All Scanners and Agents supported in the 7.5x and 7.60 releases of this product are supported in the 7.61 
release. Refer to the Compatibility Matrix for the 7.5x and 7.60 release of interest for the list of all supported 
platforms. 

 
If you upgrade from a previous release, it is possible to use the Scanners and Agents from 
previous releases if you explicitly specify the Scanner and Agent versions using the configuration 
options on the following pages: 
Administration > System Configuration > Scanner deployment

Administration > System Configuration > Agent communication
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Obsolete Features  
All features in 7.60 are supported in release 7.61. See Compatibility Notes. 

 

Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site: 
http://www.adobe.com/

The following PDF documents are available in the DDM Inventory Web UI: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 
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Installation Notes 
Instructions for installing DDM Inventory are documented in the Installation and Initial Setup Guide 
provided in Adobe Acrobat (.pdf) format.  

 Perl, MySQL, Tomcat and Apache are standard parts of the DDM Inventory, included with each 
server installation. If you have these components installed already, make sure to remove them 
before installing DDM Inventory. You may NOT substitute any other technologies in place of the 
standard installation. 

Software and Hardware Requirements  

The following sections detail the requirements for the DDM Inventory server and client components, 
respectively. 

Client Requirements 

The DDM Inventory client components (Analysis Workbench, SAI Editor, SAI Update Wizard, System 
Panel, and Viewer) have the following requirements: 

Resource Requirement 

Operating System Windows XP/Vista, Windows Server 2003/2008 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

See Help > Compatibility Matrix in the DDM Inventory GUI for 
versioning information 

Server Requirements 

The DDM Inventory Server can be installed on 32-bit versions of Windows Server 2003 (SP1, SP2, or R2) or 
Windows Server 2008 (SP1) or the 64-bit version of Windows Server 2008 (SP1 or SP2). Refer to the 
Compatibility Matrix for information about all supported platforms. 

Recommended Server Platforms 

For large servers (up to 50,000 devices), the following is recommended: 

• HP Proliant Model: DL380 G5 (Performance)  

• CPU: 2 x Quad Core (Intel® Xeon® 5400 series)  

• Memory: 8 GB 

• Disk: See the Storage Requirements section below. 

For medium servers (up to 15,000 devices), the following is recommended: 

• HP Proliant Model:  DL360 G5 (Performance) 
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• CPU: 1 x Quad Core(Intel® Xeon® 5400 series) 

• Memory: 6 GB 

• Disk: See the Storage Requirements section below. 

Sample Server Scenarios 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the DDM 
Inventory installation. 

The information presented below is for illustration purposes only.  Proper sizing of the DDM Inventory 
server(s) may require the assistance from a qualified architect.  HP recommends utilizing experienced 
resources to assist in architecture and the initial deployment of DDM Inventory.  Among the factors that 
need to be considered and which will impact the infrastructure architecture are the following: 

• Number of and distribution of devices (such as if slow WAN links exist between large population groups) 

• Type of and amount of information collected (examples below demonstrate the impact software 
utilization will have on overall system capacity) 

• Frequency of scans (the example below assumes a bi-weekly scan interval, more frequent scanning may 
require additional server capacity) 

• Amount of data collected (the examples below assume an average scan file size of ~250KB, which is 
representative of an average PC (large servers may generate considerably more data and therefore 
require additional capacity to process the data) 

• Environmental factors, such as integrations with other products, network characteristics, and 
operational requirements may impact the architecture of the DDM Inventory solution 

• The number of XML Enrichers that are running on the server 

• The settings in the virus checker installed on the server. Virus checking can add significant overhead. 

Table 1 – Suggested Hardware Requirements 

Discovered 
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Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000  x x 7 2+ CPUs or cores 260 
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Memory 
(GB) CPU* 

Disk 
(GB) 

3.6 GHz 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 
2 CPUs or cores 
3.6 GHz 50 

• CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP DDM Inventory consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• “Backup Scan Files” is enabled (on average, each scan file is 250KB) 

• “Delta scanning” is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• “Statistic Export” is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

Storage Requirements  

DDM Inventory is a highly I/O intensive application. High I/O performance of the disks where the data 
resides is crucial to the correct operation of DDM Inventory. Disks need to reside local to the DDM Inventory 
server or on a high performance SAN.  Network drives and clusters are not supported. Some customers have 
reported problems with SAN environments so they are not recommended.    

Benchmark your disk I/O performance prior to installing DDM Inventory for management of any large 
environment. For a medium to large DDM Inventory server deployment, minimum recommended 
throughput (as benchmarked on an idle system when the DDMI Inventory server is not running) is  
70 MB/sec for read accesses and 40MB/sec for write accesses. 

Your disk space requirements may differ depending on how you are using DDM Inventory. 

 For performance reasons, the disk where DDM Inventory data is stored should have at least 4K 
clusters. 

For the average size of scan files, refer to the “Disk Space Considerations” chapter in Installation and Initial 
Setup Guide. The inventory data collected in the scan file is stored in compressed format. For processing, it 
gets extracted and populated into the database. In addition, if delta scanning is enabled, DDM Inventory 
keeps a copy of the original scan file as well as the enriched copy. Because of these extra disk space 

14 



requirements, we recommend that you budget at least 5 times as much disk space for each device being 
scanned. 

 If your average scan file size is large, adjust your disk space requirements accordingly. 

Recommended Fault Tolerance Configurations 

The recommended fault tolerance configurations are the following: 

• Raid 1 

• Raid 1+0 

DDM Inventory must be installed on a local disk. It cannot be installed on network drives, SAN drives, or 
clustered devices. DDM Inventory has been tested and can be successfully installed in a RAID (redundant 
array of independent drives) level 0 and level 1 environment.   

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 
out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 
configuration does not provide for redundancy. It improves performance but does not deliver fault tolerance. 
If one drive fails then all data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 
failure. It results in increased read performance with very small performance degradation when writing. The 
array continues to operate as long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 
for DDM Inventory. For large networks, level 0 can also be used if performance is more important than fault 
tolerance. RAID level 5 is not supported. 

Upgrading from Earlier Releases 

For information about upgrading from earlier releases of DDM Inventory refer to the “Upgrade and 
Migration Scenarios” chapter in the Installation and Initial Setup Guide. 
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Enhancements and Fixes 
The following items were fixed in the current software release (identified by error tracking number). 

Table 2  Enhancements 

Number Location Description 

QCCR1C29316 Solaris SPARC Scanner Detection for UltraSPARC T2+ CPU has been added. 

QCCR1C29662 SAI Editor 

The application rules have a new Description field to 
describe the rule. When the rule is triggered, it creates a 
new version in the SAI specified to receive rule-based 
items (auto.zsai by default). The rule’s description is 
then used for this application version description. 

QCCR1C30497 Scanners 

The ignore logic used in asset sequence fields has been 
improved to better handle hardware fields with multiple 
values. If the ignore field is matched, the scanner will 
search for the next matching value in the same field, 
where as previously the next field in the sequence would 
have been evaluated. This is particularly useful for a 
sequence field pointing to a MAC address hardware field. 
It is now possible to include known fake MAC addresses 
in the Ignore Strings option and the scanner will try to 
select a MAC address that does not match a known fake 
value list. 

Table 3  Problems Fixed 

Number Location Description 

QCCR1C20555 Server A race condition has been eliminated in the XML Enricher 
when processing delta scan files. 

QCCR1C29285 Server 

VMware discovery memory usage was reduced 
significantly so that Virtual Center deployments that 
contain extremely large numbers of hosts and images can 
be handled correctly.  

QCCR1C29303 Express Teacher 
Duplicate name of publisher, application, release, or 
version are not allowed in the Express Teacher. A warning 
message appears if the name already exists.  

QCCR1C29336 Server 
The Aggregate database table 
hwOSContainerProperties can be verified during the 
startup sequence. 

QCCR1C29366 
Administration > 
System Configuration > 
Scan Processing 

When an SAI is deleted from <DATADIR>\SAI directory 
on the server, the UI reports the file as missing. Changing 
the configuration by removing this SAI allows XML 
Enricher to start correctly. 

QCCR1C29392 Windows Agent The Utilization plug-in can work properly even if the 
registry keys do not exist prior to the installation. 

QCCR1C29400 Mac OS X Scanner The CPU speed and physical memory size detection of 
certain MAC machines has been corrected. 
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Number Location Description 

QCCR1C29437 Express Teacher 

When you enter more than 255 characters into the 
Description fields of the Publisher, Application, or 
Version, the express teacher no longer shows an error 
message. 

QCCR1C29476 Windows Scanner 
Installed patch information is properly detected on 
Windows XP, Windows 2003, and Windows 2008 64-bit 
platforms.  

QCCR1C29533 Reports The search capability in the Reports framework returns 
correct results for strings with multi-byte characters. 

QCCR1C29534 Reports 
The strings containing "<" will not be truncated and 
appear properly in the reports. 

QCCR1C29536 Find 

When the remote server Find tool cannot find an IP 
device, the system will send the right remote server ID to 
Device Manager to refer to the right DDM Inventory 
server. 

QCCR1C29580 Server 
The SNMP trap notification messages generated by the 
server report the sysUpTime argument. 

QCCR1C29581 Find The Find tool in the Aggregator web GUI searches the 
Aggregate database only. 

QCCR1C29650 SAI Editor 

The SAI Editor was unable to load an SAI file which had a 
release relation pointing to a non-existent release. The 
SAI Editor is now able to correct this error by removing 
such a release relation. 

QCCR1C29705 Scanners The scanner will not exit when running on certain ELF 
files that do not conform to the standard format.  

QCCR1C29719 Server 
DDM Inventory prohibits users from being able to execute 
some remote commands on the server in certain 
situations. 

QCCR1C29720 Server 
Restoring a backup from Enterprise Discovery 2.5x is able 
to handle the case where there is no user defined Agent 
Configuration Profile. 

QCCR1C29744 Scanner Generator When creating a scanner with non-ASCII names, the 
scanner name appears properly. 

QCCR1C29779 Windows Agent 

Utilization data is consolidated in a case insensitive way 
so that the program paths will be unique even if the same 
path is reported using lower, upper, or mixed case strings, 
depending on the launching method. 

QCCR1C29794 Windows Scanner 
The Windows scanner no longer fails while detecting 
network data on some computers running Windows Server 
2008.  

QCCR1C29858 Solaris SPARC Scanner The CPU speed was not detected in some cases – this has 
been corrected. 

QCCR1C30081 SAI Editor The SAI Editor no longer allows application rules to be 
edited in a Master SAI.  
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Number Location Description 

QCCR1C30145 
Administration > 
Discovery Configuration 
> Device Groups 

The Administration > Discovery Configuration > Device 
Groups page has no invalid values, such as 
"015.178.177.001" in the "Default server gateway ip" or 
"Default server subnet range". 

QCCR1C30151 SAI Editor SAI Editor can exit properly. 

QCCR1C30161 Viewer No error message is reported when loading a scan file by 
the Viewer or other analysis tools.  

QCCR1C30200 SAI Editor The SAI IDs can be properly reconciled when the master 
SAI is loaded after the user ID.  

QCCR1C30216 Reports The version name and description are not separated with 
“<BR>” in the Software Inventory Reports. 

QCCR1C30240 Server 

A race condition, which causes a Discovery Engine crash 
when the same device is simultaneously discovered by 
several discovery sources (one being Call Home), has been 
addressed. 

QCCR1C30246 Server The final step (directory rename) in the backup process 
has been improved. 

QCCR1C30265 
QCCR1C30296 

Linux Scanner 
The hwHostOS and hwOSServiceLevel fields were not 
detected correctly on some flavors of Red Hat and SUSE 
Linux – this has been corrected. 

QCCR1C30276 Analysis Workbench The Analysis Workbench no longer crashes during the 
application teaching process.  

QCCR1C30294 
QCCR1C30756 

Express Teacher 
Changing the Express Teacher settings takes effect 
immediately without having to restart the browser. 

QCCR1C30312 
SAI Editor 
Analysis Workbench 

When unloading SAIs in the SAI Editor and Analysis 
Workbench, the SAI used for rule-based items (Auto SAI) 
is now set correctly and no longer set to the Master SAI or 
an incorrect User SAI. 

QCCR1C30333 Windows Scanner Software Utilization data is collected properly when a 
non-admin user is logged in. 

QCCR1C30365 Server 
The agentless scanning workflow correctly sets the 
destination directory for saving the scan file under all 
circumstances. 

QCCR1C30493 Web UI 
The home page warning message about the server not 
meeting the hardware requirements is correctly reported 
on all supported server platforms. 

QCCR1C30500 Device Manager > 
Diagnosis panel 

The scan file log file can be retrieved when the Device 
Manager is opened from the Aggregator server  

QCCR1C30547 Server The log server can keep operating without restarting 
several times a day.  

QCCR1C30625 UNIX Scanners 
UNIX scanners were not able to scan Network Drives in 
some cases and detected their size as 0 - this has been 
corrected. 
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Number Location Description 

QCCR1C30685 Solaris Scanner 

When multiple network cards were installed on a Solaris 
server, the Solaris scanner was not always able to detect 
MAC addresses for all network cards. With enhanced 
detection, the Scanner can detect all MAC addresses as 
long as it has root privileges. 

QCCR1C30779 Express Teacher 
No error appears when using Express teaching:  
“Application data cannot be displayed because the 
communication with the server has failed”. 

QCCR1C30799 Server 
The Agent Communicator closes all sockets for failed SSH 
connections to avoid an increasing number of connections 
staying open for devices with a broken SSH daemon. 

QCCR1C30865 Windows Agent Registry handle and socket leak issues identified in some 
cases have been corrected.  
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Known Problems, Limitations, and Workarounds 

Agents 

• When you install the Agent on Windows Vista machines using an account other than the 
"Administrator" account, the firewall exception is not added into the exceptions list (QCCR1C382).  

• On Mac OS X 10.4.10 and above, there may be a problem with contacting the Agent because it can be 
blocked by a firewall. The Agent port needs to be enabled manually either via System Preferences > 
Sharing > Firewall or via the XServe administration tool in case of centralized administration 
(QCCR1C674). 

• The Windows Agent running on Windows 2000 Advanced Server, Windows 2000 Server, or Windows 
2000 Professional might leak file handles (QCCR1C30865). 

Scanners 

• In the Scanner Generator if a previously generated file is used to populate the Scanner Generator 
options and software scanning is disabled, the Scanner will still attempt to store any previously 
configured custom stored files (QCCR1C19042). 

• Scanners may fail if the scanner log file is extremely large in size (QCCR1C20445). 

• In some cases when a directory name starts with a “~” character, the Solaris scanner may fail when 
scanning. (QCCR1C29884). 

• On older versions of some HP-UX 11.11 systems, the scanner may fail to complete scanning. 
(QCCR1C30205). 

• In some cases the HP-UX ia64 scanner may fail if a directory has an extremely long name. 
(QCCR1C30299). 

• When the network card is inactive, the MAC Address cannot be detected on AIX (QCCR1C30318). 

• In some cases the hwMonitorSerialNumber collected by the Windows scanner may differ between 
previous versions of DDM Inventory and DDM Inventory 7.6x. (QCCR1C30340). 

•  When running on some Linux devices, the scanner may display the message “Warning: 
OSExecCommand” and fail to finish scanning. (QCCR1C30506) 

• In some cases the wrong registry key may be read when running scanner on Windows XP 64-bit 
machines. (QCCR1C30657) 

• In some cases, the Windows scanner may not properly detect the number of cores on an Intel E5520 
CPU. (QCCR1C30814).  

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the “Treat field as 
a File Name’’ option is selected, the “Replace invalid characters with’’ field must be populated as well, 
even if the “Delete invalid characters’’ option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (QCCR1C1275). 

• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (QCCR1C1480). 

20 



• The Analysis Workbench sample script does not run on Windows 2008 because the default directories 
are not set correctly. The script works properly on all other supported platforms (QCCR1C19475). 

Server Installation 

• After uninstalling, the branding registry keys are left over (QCCR1C1434).  

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(QCCR1C16520 and QCCR1C1472). 

• When uninstalling DDM Inventory on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (QCCR1C2405). 

• DDM Inventory with a Network Topology license should not be installed on VMware (QCCR1C5271). 

• The SNMP extension registry key may not be removed on some Windows 2008 server installations 
(QCCR1C29306). 

Server 

• In some cases, the ID assigned to the auto.zsai and the user.zsai files may be the same. This 
results in the inability to load both files into the client tools at the same time (QCCR1C4448). 

• Older OpenSSL DLLs in the system PATH can affect the DDM Inventory Apache server and Perl 
engines (QCCR1C5447). 

• If your server has another service using port 80, the HP Discovery Apache service will not run properly. 
As a workaround, you can comment out the “Listen 80’’ directive in the httpdf.conf file 
(QCCR1C6670). 

• If there is a MySQL query that takes too long, DDM Inventory will not function properly and you may 
need to restart System Monitor to recover (QCCR1C7409). 

• In some cases, purged devices may appear in the modeling queue despite already having been purged 
(QCCR1C19165). 

• VMware discovery may, in some cases, use an incorrect IP address if the VMware image has been 
recently powered off (QCCR1C19379). 

• Firefox 3.x page navigation may appear incorrect in some cases (QCCR1C19250). 

• Running JRE 1.5 and Firefox 3.x on Vista or Windows Server 2008 machines may cause the applets and 
the browser to close (QCCR1C19437). 

• Sometimes when logging into the DDM Inventory server, a pop-up window opens with the message 
“Jscript compilation error: Expected ‘}’”.  This problem occurs as a result of calling Java Applets from 
Internet Explorer (this issue does not seem to occur with Firefox). The problem is not specific to DDM 
Inventory and can be seen on various Web pages where Applets are present. Note that the pop-up 
window opens with this message only if the “Disable script debugging” option is disabled. Otherwise, if 
this option is enabled, only a warning icon (yellow triangle containing an exclamation mark) will appear 
on the left-side of the Internet Explorer taskbar when this problem occurs. As determined so far, this 
problem does not occur if you are running JRE 1.4 or earlier. This problem has occurred on both Internet 
Explorer version 6 and version 7 (QCCR1C19591). 

• If a DDM Inventory service is interrupted while in the starting phase, the system monitor service may 
not successfully be able to start (QCCR1C20408). 

• If a non administrative user logs into the Windows server, an error indicating that the syspanel.log 
file cannot be created may occur (QCCR1C20437). 
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• If agent and agentless scanning is enabled for a property group, in some cases installing and then 
uninstalling an agent may result in DDM Inventory not recognizing that a device has an agent on it 
(QCCR1C29364). 

• The log server can keep operating without restarting several times a day. (QCCR1C30547) 

• If the server runs out of disk space, events cannot be imported into the database even if the disk space is 
made available (QCCR1C30550).  

• In some cases when a user clicks on a link to open a scan file using the Windows Viewer or the scanner 
debug log file, a login box may appear.(QCCR1C30892) 

• If the agent or agentless bandwidth threshold is set to a low number, the communication between the 
server and the remote machine may fail.(QCCR1C30939) 

• The Location of Scanner Executable for Agentless Scanning option is not used when DDMI runs a scan, 
instead the default location is used.(QCCR1C30956) 

• After performing a Level 1 or Level 2 data delete, the Express Teacher might not function correctly.  
Restarting the System Monitor Service will correct the issue. (QCCR1C31023) 

System Panel 

• When there are multiple instances of the DDM Inventory System Panel running on the Server, only one 
of the System Panel instances will display Port Usage information (QCCR1C20409). 

Web User Interface 

• After an agentless scan (using SSH) has successfully been run, the account used for this connection 
cannot be changed unless you delete the account from the DDM Inventory UI (QCCR1C19398). 

Applets 

• The Express Teaching applet may allow the user to teach an application even though it is set to disabled 
in the UI.  The items taught will not be added to the SAI file (QCCR1C29369). 

• Find tool or IP Find does not find all devices if an IP address is associated with multiple devices 
(QCCR1C30596).  

Administration 

• Depending on the licenses, the “Resource/ Environment manage’’ option in Discovery Configuration may 
not have any effect (QCCR1C7034). 

• In the Service Analyzer, device breaks may show up in the filter list for line breaks (QCCR1C18988). 

• When VMware discovery is run on a VirtualCenter device, the VMware images on it may appear in the 
inventory even if the IP addresses are not in the IP ranges to be discovered (QCCR1C29277). 

Web Asset Questionnaire 

• In Internet Explorer, when connecting to the main page through a proxy server, the “You are connecting 
from’’ IP address reported will be the IP address of the proxy server not that of the remote computer 
address (QCCR1C764). 

• The UI may show non-printable characters in text fields (QCCR1C2408). 
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Reports 

• The + symbol in the Navigation Tree next to reports is missing. This does not affect functionality 
(QCCR1C18894). 

• When using HP Client Automation Enterprise Reporting Server, some new CPU type may not be 
displayed correctly (QCCR1C19380). 

• The Alarm summary of Collisions, Frame Relay FECN/BECN, DE Inventory reports and Device Load 
Average may report N\A instead of the correct values (QCCR1C29312). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (QCCR1C5673). 

Internationalization 

• Various UI screens (reports, status reports, Device Manager, and so on) format the “day of the month’’ 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (QCCR1C416). 

• When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (QCCR1C490). 

• There are several problems with the SAI Editor accepting characters in the Korean code page 
(QCCR1C507, QCCR1C508). 

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (QCCR1C2043). 

• SAI files with Chinese names may appear incorrect when viewing them with the DDM Inventory web 
user interface (QCCR1C19372). 

• If the name of a User zSAI file contains Chinese characters, the XML Enricher may not be able to load 
that zSAI file (QCCR1C19402). 

• Recognition rules written in Chinese may not recognize all versions (QCCR1C19610). 

• Some locales may not report the total disk space correctly in some cases (QCCR1C19614). 

• Virtual Machine names with non-English characters appear as garbage characters. (QCCR1C29618). 
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